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[2] Arduino UNO Board from: http://en.wikipedia.org/wiki/Arduino
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[5] Photo Diode from: http://it.irpct.ac.th/elearning/mod/resource/view.php?id=48
[6] Motion Sensor BP4001 datasheet from :http://www.es.co.th/detail.asp?Prod=17601362

[7]photodiode TSL257-LF datasheet from :

http://www.datasheetlib.com/datasheet/1166721/ts1257-1f taos-texas-advanced-optoelectronic-

solutions.html
[8]Arduino UNO Board Atmega328datasheet from:
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[45 this specification is for a provisional tarzet. the contents might change without notice)

1. STRUCTUEE

Assembled product using printed ewewt board

1. PRODUCTS SENS0OR MODULE
J. TYPE BP4001

4. APPLICATION LEDLIGHTING

5. FUNCTION SENSOR MODULE

D52 Target spec.

BP4001 is sensor module which is applied for DC4V~5.5V input.
It bulds in a sensor cireuit which can drive output voltage VDD and its output cwrent 15 10mA.

6. DETECTION PERFOERAANCE

Items Standard value Conditions concerming target
Detection Fange Max Sm 1 The temperature difference between the target
Horizontal 110° (£537 ) and the swroundmes should be supenor to
Detection Vertical 100° (5059 1 14;0.. .
Ares 2 Movement speed: 1.0m s
Detection Zone 3fzones 3.Target concept 1 human body
(Size:T0O0 x 250 mm)

Depending on the target’s speed and its temperature difference with the surroundings, detection can ocour
at a range supenor to the above valne. However, pleaze nse thus sensor accordmg to the specifications

7. ABSOLUTE MAXIMUM EATINGS
These are the values which must not be exceeded at any fime under any application or any test conditions.
Please make design keepmg epough margms accordingly.

(Ta=25C)
Nao. PARAMETER SYMBOL [ RATING UNIT REMAFRE
1 |Input voltage Vi -0.3~5.5V v DC
2 | Cufput current Io 10 md
Allowable maximum surface . Ambient temperature +
3 Temax 105 \ -
temperature the module self-heating = Temax
4 |Operating temperature range Topr -20~60 C Refer to derating curve
5 |Storage temperature range Tstg -25~T0 iC

— — —
DESIE CHECE ADPRON:

e

DATE : 28/JAN2013

SPECTFICATION Moo - BP4001-A-001-E (Lead Fres)

REVA

ROHM Co. Ltd.

TSZ22111-04
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3. ELECTRICAL CHARACTERISTICS

definition of 1tems

{(Unless otherwize noted, Vi=EDC5VIo=1md Ta=25°C)

SPEC _ TEST
Na. PARAMETER SYMBOL M | TYP TMAx UNIT CIRCUIT REMARE
1 | Input voltage range Vi 40 3 55 DC - DC
2 | Output voltage Vo - VDD - v Figl
3 | Ouiput cwrrent Io 0 1 10 ma Vi=DC4 0~535V
4 | Cirewit stability timme Twu - - 30 Sec
5 .'E-ten:.nr detection retention tor 30 ) 45 Car
fime
6 |c - - - 400 uA Ie={m&
onsumption current W - - 3000 IA -
9 TIMMING CHART
OM -
OFFQ. ; 5
Present(D) E C ' © O ©
Abszent - T :
H ' ' i
Senzor Output Voltage Maintain during Carrying out output maintenance
ON 30 s is conimisd
OFF i : ! '
‘- T — B e T E—
H Twru Tw 1==2%9zac | Tw !
FIG] Timming chart
[Durations]

Twu: Civeunit stability time. About 30sec (max_.)

It becomes the sensor output OM state with or without a detection object after power supply injection dunng circunt
stability fime.

Tw: Sensor detection retention time. About 30sec (min )

It 15 the time when a sensor output ON state maintains it after the sensor detechion.

ROHM Co. Ltd. |rEVA SPECIFICATION No. : BP4001-4-001-E (Lead Free)

TSZI2111-05
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10. TEST CIRCUIT
Motion Control CH1-2 []vnu1=\TDD
Sensor circuit Vout
Io

| MLM-1|
T

v

.

e

FIG2

Test curcut

ROHM Co..Ltd.

REV.A

SPECIFICATION No. : BP4001-A-001-E (Lead Free)

TSZ22111-05
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11. DETECTION RANGE

from a top to the bottom

In the detechon range a honzontal perpendicular method changes by a point to establish.
When attached to a wall, it spreads 2 maxumum of 5m with a 7.5m of konizontal direction, vertical direction of 6.0m

Horzontal direction

110°(=55%)

Vertical direction

100°(=507)

. Sensor+ Lens

(Distan g 28MF ===g,
-~ - ____,_,.3:“'

- Max, 7.9

. ]
, Distance:2.6m
i’ e *
A "
P 1Y
¥ [
! 1
., Distance: 2.6 i H
i r
L ]
\ i
Y ’
, rd
¥, #
. < Image = -
M ="

X
|

Max 6,0m

-

Sensor: IRS-B3405T02
Fresnel Lens: IML-0669

FIG3 Detection range

ROHM Co. Lid.

REVA

SPECIFICATION No. : BP4001-A-001-E (Lead Free)

TSZ22111-05
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PRODUCTS

Arranpement of connector

ROHM T e
POWER. MODULE BP4001 (Lead Free) 3/10
SEMICONDUCTOR
12, DIMENSIONS (UNIT:mm)
[Front side] 20.0+0.5 n 12.TMAX.
LETYF.
Mk | O B\P4ﬂl[}1 a
ROHM 8 |£ :|
¥ N _ il
] o m -
i e \ [ e
i3 I...-‘ T _.. |:| | :|
= i |=8) ) .
\ TTT—TTT I DDDD L [
\:—_—_:_-:/ o \"--_
7uMa] | [3anax
[Back zide]
[33:
- CHt
]
o EDE] O & $CN1 is made by JST
D; E. = a SMOIB-SRS5-TB 15 in use
i =g
= = o
Omm = = Cf ‘o
o[J8cBE ™ o
0 oo g
FIz4 Dimencions
Marking=
BP40dl : Type name

240+ 4 b & | : Produchon Lot Mumber (3 dizits)

(e w--249% & i & —45th week of 2012 % A A A)

Location [zerial)

Location

The externals mspection standard is assumed to be a ROHM standard.

Terminal No. Terminal Name
CHI1-1 GHND termunal
CH1-2 Cratput teromnal
CH1-3 Input terminal

ROHM Co..Ltd.

REVA

SPECIFICATION MNo. : BP4001-A-001-E (Lead Free)
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RDHm PRODUCTS TYPE PAGE
POWER MODULE BP4001 (Lead Free) 610
SEMICONDUCTOR

13. PACKINGSPEC

TBD

14, MANUFACTURING FACTOREY

ROHM ELECTRONICS DALIAN CO_LTD. (CHIMNA)

ROHM Co..Ltd. |rEva SPECIFICATION Mo. : BP4001-A-001-E (Lead Free)
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RDHm PRODL;:C')I‘J.E’ER. MODULE T FAcE

BP4001 (Lead Free) 710
SEMICOMDUCTOR

15, OPERATING PREECAUTIONS
15-1. Caution

1} Moving Direction Concept

As detailed on the diagram, please mstall the sensor so that the expected frespassing direchon corresponds to the
axis X oraxis ¥

In some cases, mtrusions that oceur parallel to the axis Z in every detechon zone, closing toward
The sensor, mav not be detected

In this direction, no
detection problem
-

In theg direction,

detactsm i WNoertar
2} Notes Regarding the Detection Zone

As shown on the diagram, the detection zone 15 polanzed.

If a target enters the detechon zones + and — at the same time, the signal are respectmvely cancelled and detection could
become impossible at maximum detection range.

{Please refer to the detection area diagram for details)

(]

Detection zone

] Bl

ROHM Co. Ltd. |rEva

SPECIFICATION No. : BP4001-A-001-E (Lead Free)
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RDHIII PRODUCTS TYPE PAGE
POWEE. MODULE BP4001 (Lead Free) 310
SEEMICONDUCTOR

15-2. Operating precautions

It may not detect in the following cases “lack of movement, no temperature change in the heat source.
Besides, it could zlso detect the presence of heat souwrce. Efficiency and reliabality of the system may

very depending on actual operating conditions. Confirm the operation under the actual operating conditions.

1} Dretecting heat sources other than the human body, such as :

a) small amimals entermg the detection area.

b} white hight source (sunlight, car headlight, etc.) directly hitting the sensor.

c) sudden temperature changes m the detection area caused by humidifier water vapor emission, or aw condibommg
system hot'cold air emassions.

2) Dufficulty in sensing the heat source

a) Glass, acrybic or sioular matenals standimg between the target and the sensor may not allow a comrect ransmission of
infrared rays.
b} Non-movement or quick movements of the heat source maide the detection area.

3) Expansion of the detection area
In case of considerable difference in the ambient temperature and the human body temperature, defection area may
be wider apart from the configured detection area.

4} Malfunction

On the character of a pyroelectnic element, it may malfunchon by the outbreak neoise output under influences of
ambient environment, such as a rapid change of ambient air temperature.

15-3. Ambient Environmental Conditions

1) Temperature: Please refer to the ABSOLUTE MANIMUM FATINGS.

2) Humidity Degree: 15~35%FH (Avoid condensation of freezing of this product)

3} Pressure:86~106KPa

4} Orrerheating, oscillations, shocks can cause the sensor to malfunction.

5) This sensor 15 not waterproof or dustproof. Aveid use in enviromments subject to excessive moisture, condensation
frost, containing salt air or dust. If a sensor 15 used with a cover installed, the imitial detection performance

specifications mav not be able to be meet. Confirm the operaton under the actual operating condifions.

&) Do not use at the environments which are dust, corrosiwe gas and salt air. If it use in those situation, 1t may causes
operation faillure, performance degradation.

ROHM Co..Ltd. |rEVA SPECIFICATION No. : BP4001-4-001-E (Lead Fres)

T5Z22111-03
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RDHIII PRODUCTS TYPE PAGE
POWER MODULE BP4001 (Lead Free) 810
SEMICONDUCTOR

15-4 Operating precautions

1) When soldering the lead wire, hand solder the sensor using the soldering iron below 350°C, and within 3 seconds.
Please avoid soldermng using solder tank, this can lead to detenoration of performance. Also please avoid bending
the lead wire to mount the sensor on to the circuit board temporanly. This will damage the sensor.

2 ) Please be careful enough for handling not to suffer stresses like bending, curving, or twisting because the shape of
product 1s extreme slender.

33 Do not use hgmids to wash the sensor. If washing flmid gets through the lens, It can reduce performance.

4 Do not use a product once fallen.

5 The sensor mav be damaged by the ® 200 volts of static electnieity. Avold direct hand contact with the pins and be

very careful when operating the product.

6 ) When wiring the product, always use shielded cables and mimimize the winng length to prevent noise disturbances.

7} The mner circuit could be destroved by a voltage surge. Use of surge absorption elements 15 kaghly recommended.

£ ) Use stabilized power supply for power supply. Because 1t may malfunction by noise supenimposed on the power

Source.

9 It may malfunction by electric noise which are static and thunder, amateur CB radio, transmission, etc.

10} Detertoration of detecting performance will happen if dirt and dust adhere to the lens.

11) The lens of the Polyethylens lens type 15 made of soft matenals{Polyethvlene). If any loads or shocks are applied to
the lens, due to deformities, and damages, this will lead to malfunction, or deterioration of the produet.

12} Operating “temperatures” and “hunudity level” are suggested to prolong usage. However, they do not guarantee
durability or humadity levels will accelerate the detencration of electrical components. Please consider both the
planned usage and environment to determine the expected reliability and length of hfe of the product.

13) It becomes a canse discolored deformed and deformed. Do not wipe with benzene, thinner and various cleanser.

14) This sensor 15 not waterproof or dustproof. Avold use m environments subject to excessive moisture, condensation,
frost, contaming salt aur or dust If a sensor 15 used with a cover installed, the imfial detechion performance
specifications may not be able to be meet. Confirm the operation under the actal operating conditions.

ROHM Co..Ltd. |rEva SPECIFICATION Mo. : BP4001-A-001-E (Lead Free)
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TSL257
HIGH-SENSITIVITY
LIGHT-TO-VOLTAGE CONVERTER

TACQSIZIE - SEFTEMBER 2007

® Converts Light Intensity to Output Voltage

® Monolithic Silicon IC Containing
Photodiode, Operational Amplifier. and
Feedback Components

® High Sensitivity

® Single Voltage Supply Operation (2.7 V to

55 V)
® Low Noise (200 pVrms Typ to 1 kHz)
® Rail-to-Rail Output

® High Power-Supply Rejection (35 dB at
1 kHz)

® Compact 3-Leaded Plastic Package
® HoHS Compliant (-LF Package Only)

Description
The TSL25T is a high-sensitivity low-noise light-to-voltage optical converter that combines a photodiode and
a fransimpedance amplifier on a single monolithic CMOS integrated circuit. Output voltage is directly
proportional to light intensity (imadiance) on the photodiode. The TEL25T has a transimpedance gain of 320 MQ.
The device has improved offset voltage stability and low power consumption and is supplied in a 3-lead clear
plastic sidelooker package with an integral lens. When supplied in the lead (Pb) free package, the device is

RoHS compliant.

Functional Block Diagram

Available Optionz

PACKAGE S PACKAGE SM

SIDELOOKER SURFACE MOUNT

(FRONT VIEW) SIDELOOKER
(FRONT VIEW)

'

o

1 2 3
GND Vpg OUT

1 2 3
GND Vpp OUT

Voltage
Cutput

DEVICE Ta PACKAGE - LEADS PACKAGE DESIGNATOR | ORDERING NUMBER
TSL25T | 0°C o TOPC 3Head Sidelocker 5 TSL257

TSL25T | 0°C o 70°C Jead Sidelocker — Lead (Ph) Free 5 TSL257-LF

TSL25T | 0°C o 70°C 3-lead Surface-Mount Sidelooker — Lead (Pb) Free SM TSL25TEM-LF

Terminal Functions

TERMINAL
NAME NO. DESCRIPTION
GMND 1 Ground (substrate). All voltages are referencad to GNO.
ouT 3 Clutput voltage
Voo 2 Supply voltage

The LUMENOLOGY * Company

Texas Advanced Optoelectronic Solutions Inc.
1007 Klein Road = Suite 300 = Plano, TX 75074« [872) 673-0739

www.taoginc.com

Copyright © 2007, TACE Ina.
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Abszolute Maximum Ratings over operating free-air temperature range (unlezs otherwise noted)t

Supply voltage, Vpp (see Note 1) e, BV
Qutput current, g e =10 MA
Dwration of short- u:lru:urtcurrentat [u:urbeh:w] 25°C 5s
Operating free-air temperature range, Ta —25°th:-E|5C-
Storage temperature range, Teyg .. ... .. e —25°C 10 B5°C
Lead temperature 1,6 mm (11 E inch) frc:-m case fc:-r 1EI uecnndu {._1 Package] ... 2B0°C
Reflow solder, in accordance with J-STD-020C or J-STD-020D (SM Pack,age] - 1

T Stresses beyond those listed under “absolute maximum ratings”™ may cause permanent damage to the device. These are stress ratings only, and
functional operation of the device at these or any other conditions beyond those indicated under “recormmended operating conditiong” is not
implied. Exposure to absclute-maximum-rated conditions for extended peniods may affect device reliability.

NOTE 1: Al voltages are with respect to GMND.

Recommended Operating Conditionz

MIN  MAX [ UNIT
Supply voltage, Voo 27 55 W
Operating free-air temperature, Ty, o T0 C

Electrical Characteristics at Vpp =5V, Ty = 25°C, 4, = 470 nm, R = 10 kQ (unless otherwize noted)
(zee Notes 2 and 3)

PARAMETER TEST COMDITIONS MIN  TYP MAX UNIT
Vo Dark voltage E-=0 o 15 my
Vop =435V, Mo Load 443
Vou  Maximum cutput voltags swing Von=45 V. AL =10k 4 4z v
Va Output voltage E. = 1.54 uWicm?, kg = 470 nm, Note 3 1.6 2 24 W
oD Temperature coefficient of dark voltage (V) T =0°Cto 70°C -15 uV~G
kg = 328 nm. see Motes 4 and & 118
A kg =470 nm, see Motes 5 and & 130
N, Iradiance respansity kp = 565 nm, see Notes B and & 158 ViuWiem?)
kg = 643 nm, see Motes 7 and & 168
PSRR Power supply rejection ratio fa- = 100 Hz, s=e Note 9 55 dB
faz = 1 khHz. s=e Mote 5 35 dB
lap Supply curmrent E. =1.54 uWicm?, & = 470 nm, Maote 3 18 35 mé&

NOTES: 2. Measured with A = 10 k2 between output and ground
3. Optical measurements are made using emall-angle incident radiation from a light-emitting dicde (LED) optical source.
4. The input imadiance is supplied by a GaN/SiC light-emitting diode with the following characteristics: peak wavelength 2, =428 nm,
spectral halfwidth A3\: = &5 nm
. The input imadiance is supplied by an InGaN light-emitting dicde with the following characteristics: peak wavelength &g = 470 nm
spectral halfwidth A3l: = 35 nm
6. The input imadiance is supplied by a GaP light-emitting diode with the following characteristics: peak wavelength i, = 565 nm
spectral halfwidth A3l: = 26 nm
The input imadiance is supplied by an AlGaAs light-emitting diode with the following charactenstics: peak wavelength 7, = 845 nm,
spectral halfwidth A3l: = 25 nm
3. Iradiance responsivity is characterized over the range Vo = 001 Wito 4.5V The best-fit straight line of Output Voltage Vo versus
rradiance E. over this range will typically have a positive extrapolated Vg, value for E. = 0.
3. Power supply rejecton ratio PSAR is defined as 20 log (AVooifl/AVo(f)) with Voolf=0) =3V and Voff=0] = 2 V.

5

=4

Copyright © 2007, TADS Ina.
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TSL257

HIGH-SENSITIVITY

LIGHT-TO-VOLTAGE CONVERTER
T

ADE0ZIE - SEFTEMBER 2007

Switching Characteristics at Vpp =5V, Ty = 25°C, ., = 470 nm, R = 10 k2 (unless otherwize noted)

PARAMETER TEST CONDITIONS MIN TYP MAX LUINIT
L. Cutput pulse rise time, 10% to 30% of final value See Motz 10 and Figure 1 180 250 us
s Output pulse fall time, 10% to 30% of final value See Mote 10 and Figure 1 150 250 us
t.  Output settling time to 1% of final value See Motz 10 and Figure 1 30 us
ntegrated noize voltage f=doto1kHz E.=0 200 wrms
f=10Hz E.=0 B
Vi Output noise voltage, ms f=100Hz E.=10 B pwVAHZ s
f=1kHz E.=0 7

NOTE 10: Switching characteristice apply over the range Vg =01 Vio 4.5 V.

PARAMETER MEASUREMENT INFORMATION

W
oo E.
Pulze 2 T
Generator I b
o Input
LED W ¥ I - e | "
(zee Note A) | ey i >—|3—.— Cutput
+
| 51257 dIE
[ I <
— =i Cutput
- (zee Note B)
TEST CIRCUIT VOLTAGE WAVEFORM

MOTES: A. The input imadiance ie supplied by a pulsed InGaM light-emitting diode with the following characteristics: i, = 470 nm,
to<1 s, f<lus.
B. The output waveform is monitored on an cscilloscope with the following characternistics: t, < 100 ns, Z = 1 M2, G = 20 pFf.

Figure 1. Switching Times

The LUMENOLOGY ® Company Copyright © 2007, TACS Ina.
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TYPICAL CHARACTERISTICS

PHOTODIODE SPECTRAL RESPONSIVITY

186

| |
T = 25°C
14

Normalized to

sy 470 nm

A1\

i

1.0 /

u:a ,/
06 /

Relathre Res pons ity

04 /
02

300 500

T00 S00 1100

i — Wawvelength - nm
Figure 2

DARK VOLTAGE

Vs

FREE-AIR TEMPERATURE

10
Voo =5V

V- Dark Vaktage - mV
(23]

o 10 20 30 40 50 &0 T0

Ta - Free-Air Temperature - *C

Figure 4

Pawer Supply Rejection Ratlo — dB

Homalized Response

POWER SUPPLY REJECTION RATIO

Vs
FREQUENCY
B0
o
=]
50 I,
a N \
20
10
]
10 102 107 10# 105 108
f - Frequency - Hz
Figure 3
HORMALIZED RESPONSE
Vs
ANGULAR DISPLACEMENT
1.0 =]
0.9 /’/ N
7N
T / Y
06 I'L
/f \\
0.4 / \
0.3 I
02 /
01 __,// lk\___
P — ]
-%0) -T0 -50 -30 -10 10 30 50 TO 50

Angular Dizplacement - *
Figure 5
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APPLICATION INFORMATION

PCE Pad Layout

Suggested PCB pad layout guidelines for the SM surface mount package are shown in Figure 6.

NOTES: A. All linear dimensions are in millimeters.
B. This drawing is subject to change without notice.

Figure 6. Suggested SM Package PCB Layout

The LUMENOLOGY * Company Copyright & 2007, TADS Ina.
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MECHANICAL DATA
The device is supplied in a clear plastic three-lead sidelooker through-hole package (S).

PACKAGE 5 PLASTIC SINGLE-IN-LINE SIDE-LOOKER PACKAGE

TOP VIEW

l 4—4.Eﬂ—b|l

260 ROS0 — 154

FRONT VIEW

SIDE VIEW
—» 1—2:m¢—1au _"'|"‘_E|'1EB
- - ote
h T
Ly 4 460
T :ﬂ_—L,___ I
Hi 15 e
0.42
14.86 + 0.50
L] || @ ¥
2x2—p - Lead Free
| —Ir| |4— 0.47 TYP Available —+ |4 042
NOTES: A. Al linear dimensions are in milimeters; tolerance ie + 0.23 mm unless otherwize stated
8. Dimension is to center of lens arc, which is located below the package face.
C.

The integrated photodiode active area is round with a typical diameter of 075 mm and is typically located in the center of the lens
and 0,97 mm below the top of the lens surface.

Index of refraction of clear plastic is 1.535.

Lead fimigh for TSL257: solder dipped. 63% Sn/37T% Pb. Lead finish for TSL257-LF: solder dipped, 100% Sn

Thiz drawing is subject to change without notice.

Figure 7. Package & — Single-In-Line Side-Looker Package Configuration

TAOS

WWW. IaEinc. com

Copyright © 2007, TADS Ina. e The LUMENOLOGY * Company
ADWANTED
DPTORLECTRAONTC

SOLUTTONS®




42

TSL257
HIGH-SENSITIVITY
LIGHT-TO-VOLTAGE CONVERTER

TACS02IE - SEFTEMBER 2007

MECHANICAL DATA

PACKAGE SM PLASTIC SURFACE MOUNT SIDE-LOOKER PACKAGE

TOP VIEW

250 ROSO —% 1,

FROMNT VIEW SIDE VIEW
R ‘ 290 ——||4—— 015 Hote B

Me— &

[
|y |
ey I

0.42

[ ¥}

|
. I
o] — 7

e
/

o.g2 +0.10 » —

-0.15 5.73 £ 0.50
%32 —pT q— @ _
+— 04T TYP Lead Free —I-| |1— 042
NOTES: A, All linear dimensions are in millimeters; tolerance is = 0.23 mm unless othenwise stated

3. Dimension is to center of lens are, which is located below the package face.
C. The integrated photodiods active area is typically located in the center of the lens and 097 mm below the top of the lens surface
D. Index of refraction of chear plastic is 1.35.
E. Lead finish for TSL2575M-LF: solder dipped. 100% Sn.
F. This drawing is subject to change without notice.

Figure 8. Package SM — Surface Mount Side-Looker Package Configuration

The LUMENOLOGY * Company
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PRODUCTION DATA — information in this document is current at publication date. Products conform to
specifications in accordance with the terms of Texas Advanced Optoelectronic Solutions, Inc. standard
warranty. Production processing does not necessarily include testing of all parameters.

LEAD-FREE (Pb-FREE) and GREEN STATEMENT

Pb-Free (HOHS) TAOS' terms Lead-Free or Pb-Free mean semiconducior preducts that are compatible with the current
RoHS requirements for all 8 substances, ncduding the requirement that lead not exceed 0.1% by weight in homogeneous
materials. Where designed to be soldered at high temperatures, TADS Pb-Free products are suitable for use in specified
lead-free processes.

Green (ROHS & no Sh/Br) TAOS defines Green to mean Pb-Free (RoHS compatible), and free of Bromine (Br) and
Antimony (Sb) based flame retardants (Br or 3b do not excead 0.1% by weight in homogeneous material).

Important Information and Disclaimer The information provided in this statement represents TAOS' knowledge and
belief as of the date that it i= provided. TADS bases its knowledge and belief on information provided by third parties,
and makes no representation or warranty as to the accuracy of such information. Efforts are underway to better integrate
information from third parties. TADS has taken and continues fo take reasonable steps fo provide representative
and accurate information but may not have conducted destructive testing or chemical analysiz on incoming materials and
chemicals. TAOS and TACS suppliers consider certain information to be proprietary, and thus CAS numbers and other
limited information may not be available for release.

NOTICE

Texas Advanced Oploelectronic Selutions, Inc. (TACS) reserves the right to make changes to the products contained in this
document to improve performance or for any other purpose, or to discontinue them without notice. Customers are advised
to contact TACS to obtain the latest product information before placing orders or designing TAOS products into systemns.

TADS assumes no responsibility for the use of any products or circuits described in this document or customer product
design, conveys no license, either expressed or implied, under any patent or other right, and makes no reprezentation that
thie circuits are free of patent infringement. TADS further makes no claim as to the suitability of its products for any particular
purpose, nor does TADS assume any liability arising out of the use of any product or circuit, and specifically disclaims any
and all liability, including without imitation consequential or incidental damages.

TEXAS ADVANCED OPTOELECTROMIC SOLUTIONS, INC. PRODUCTS ARE NOT DESIGNED OR INTENDED FOR
USE IN CRITICAL APPLICATIONS IN WHICH THE FAILURE OR MALFUMCTION OF THE TAOQS PRODUCT MAY
RESULT IN PERSOMAL INJURY OR DEATH. USE OF TADS PRODUCTS IN LIFE SUPPORT S3YSTEMS IS EXPRESSLY
UNAUTHORIZED AND ANY SUCH USE BY A CUSTOMER 18 COMPLETELY AT THE CUSTOMER'S RISK.

LUMEMOLOGY, TAOS, the TADS loge, and Texas Advanced Optoslectronic Solutions are registered trademarks of Texas Advanced
Optoelectronic Solutions Incorporated.

Copyright & 2007, TADS Ino. The LUMENOLOGY * Company

TEXAS
AOWARTED
DPTRELECTROMTC
SOLUTIOHS®

TAOS

i wharw taosinc.com




Arduino UNO Board datasheet

Arduino UNO

MADE
IN XTALY
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Product Overview

The Arduino Uno is a microcontroller board based on the ATmega328 (datasheet). It has 14 digital
input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, a 16 MHz crystal oscillator, a
USB connection, a power jack, an ICSP header, and a reset button. It contains everything needed to
support the microcontroller; simply connect it o a computer with a USB cable or power it with a AC-to-DC
adapter or battery to get started. The Uno differs from all preceding boards in that it does not use the FTDI
USB-to-serial driver chip. Instead, it features the Atmega8U2 programmed as a USB-to-senial converter.

"Uno" means one in Italian and is hamed to mark the upcoming release of Arduino 1.0. The Uno and version
1.0 will be the reference versions of Arduno, moving forward. The Uno is the latest in a series of USB
Arduino boards, and the reference model for the Arduino platform; for a comparison with previous versions,
see the index of Arduine boards.

g?)%hcri‘iiitions Page 2
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S e Page 7

B RS radiospares RapioNICS

44



Technical Specification

EAGLE files: arduino-duemilangve-uno-design zip Schematic: arduino-unc-schematic pdf

Summar

Microcontrofler
Operating Voltage

ATmega328
5V

Input Voltage (recommended) 7-12V

Input Voltage (limits) 6-20V
Digital 'O Pins 14 (of which 6 provide PWM output)
Analog Input Pins 6
DC Current per /O Pin 40 mA
DC Current for 3.3V Pin SO mA

32 KB of which 0.5 KB used by
T bootlcader

2KB

1KB

e

16 MHz
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The Arduino Uno can be powered via the USEB connection or with an extemal power supply. The power
source is selected automatically.

External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) or battery. The adapter
can be connected by plugging a 2. 1mm center-positive plug into the board's power jack. Leads from a
battery can be inserted in the Gnd and Vin pin headers of the POWER connector.

The board can operate on an external supply of 6 to 20 volts. If supplied with less than 7, however, the 5V
pin may supply less than five volts and the board may be unstable. If using more than 12V, the voltage
regulator may cverheat and damage the board. The recommended range iz 7 to 12 volts.

The power pins are as follows:

+  VIMN. The input voltage to the Arduino board when it's uging an external power source (as opposed to
5 volts from the USEB connection or other regulated power source). You can supply voltage through
this pin, or, if supplying voltage via the power jack, access it through this pin.

+« 5BV, The regulated power supply used to power the microcontroller and other components on the
board. This can come either from VIN via an on-board regulator, or be supplied by USE or another
requlated 5V supply.

= V3, A 33 volt supply generated by the on-board regulator. Maximum cumrent draw is S0 ma.

+ GND. Ground pins.

The Atmega32s has 32 KB of flash memory for storing code (of which 0,5 KB is used for the bootioader); It
has also 2 KB of SRAM and 1 KB of EEPROM (which can be read and written with the EEPROM library).

Input and Output

Each of the 14 digital pins on the Uno can be used as an input or output, using pinMode(), digitalWnte{) and
digitalRead() functions. They operate at 5 volts. Each pin can provide or receive a maximum of 40 ma& and
has an imternal pull-up resistor (disconnected by default) of 20-50 kOhms. In addition, some pins have
specialized functions:

« Serial: 0 (RX) and 1 (TX). Usad to receive (RX) and transmit (TX) TTL seral data. TThese pins are
connected to the corresponding pins of the ATmegaSU2 USB-to-TTL Senal chip .

+ External Interrupts: 2 and 3. These pins can be configursd to tigger an intemupt on a low value, a
rising or falling edge, or a change in value. See the aitachintermupt() function for details.
PWM: 3, 5,6, 9, 10, and 11. Provide 8-bit PWM output with the analogWiite() function.
SPI: 10 (85), 11 (MOSI1), 12 (MISO), 13 (SCK). These pins support SPl communication, which,
although provided by the underlying hardware, is not curmently included in the Arduine language.

« LED: 13. There iz a built-in LED connected to digital pin 13. When the pin is HIGH value, the LED is
on, when the pin is LOW, it's off.

E ﬁ Radiospanes RADIONICS ‘éL
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The Uno has 6 analog inputs, each of which provide 10 bits of resolution (i.e. 1024 different values). By
default they measure from ground to 5 volts, though is it possible to change the upper end of their range
uzing the AREF pin and the analogReference() function. Additionally, some pins have specialized
functionality:

« FC:4(SDA) and 5 (SCL). Support FC {TWI) communication using the Wire librany.
There are a couple of other pins on the board:

+ ARFEF. Refersnce voltage for the analog inputs. Used with analogRefersnce().
+ Reset. Bring thiz line LOW to reset the microcontroller. Typically used to add a reset bution to
shields which block the one on the board.

See also the mapping between Arduino pins and Afmegadad ports

Communication

The Arduing Uno has a number of facilities for communicating with a computer, another Arduino, or other
microcontrollers. The ATmega32s provides UART TTL (5Y) 2erial communication, which is available on
digital pins 0 (RX) and 1 (TX). An ATmegaBl2 on the beard channels this serial communication over USB
and appears as a virtual com port to software on the computer. The "8U2 firmware uses the standard USB
COM drivers, and no external driver is needed. However, on Windows, an *.inf file is required..

The Arduino software includes a senal monitor which allows simple textual data to be sent to and from the
Arduing board. The RX and T LEDs on the board will flash when data is being transmitted via the USB-fo-
senal chip and USB connection to the computer (but not for seral communication on ping 0 and 1).

A SoftwareSernal library allows for senal communicaticn on amy of the Uno's digital pins.

The ATmega32d also support 12C (TWI) and SP1 communication. The Arduino software includes a Wire
library to simplify use of the 12C bus; see the documentation for details. To use the SPl communication,
please see the ATmegal323 datasheet.

Programming

The Arduino Uno can be programmed with the Arduino software (download). Select "Arduino Uno wi
ATmega32s” from the Tools > Board menu {according to the microcontroller on your board). For details,
see the reference and tutodals.

The ATmega328 on the Arduino Uno comes prebumed with a bootloader that allows you to upload new code
fo it without the use of an external hardware programmer. It communicates using the cnginal STKS00

protocol (reference, C header files).

You can alzo bypass the bootioader and program the microcontrofler through the ICSP (In-Circuit Senal
Programming) header; see these instructions for details.

The ATmegaBll2 fimmware source code is available . The ATmegaSU2 is loaded with a DFU bootloader,
which can be activated by connecting the solder jumper on the back of the board (near the map of ltaly) and
then resetting the SU2. You can then use Atmels FLIP scftware (Windows) or the DEU programmer (Mac
05 X and Linux) to load a new fimmware. Or you can use the ISP header with an external programmer
{overwriting the DFL bootloader).

B ﬁ Radiospsres RADIONICS ‘éL



Automatic (Software) Reset

Rather than reguiring a physical press of the reset button before an upload, the Arduino Uno is designed in a
way that allows it to be reset by software running on a connected computer. One of the hardware flow control
lines (DTR) of the ATmegaBU2 is connected fo the reset line of the ATmega32d via a 100 nanofarad
capacitor. When this line is asserted (taken low), the reset line drops long enough to reset the chip. The
Arduino software uses this capability to allow you to upload code by simply pressing the upload button in the
Arduino environment. This means that the bootloader can have a shorter timeout, as the lowering of DTR
can be well-coordinated with the start of the upload.

This setup has other implications. When the Uno is connected o either a computer running Mac OS5 X or
Linux, it resets each time a connection is made to it from software (via USB). For the following half-second or
s0, the bootloader is running on the Uno. While it is programmed to ignore malformed data (i.e. anything
besides an upload of new code), it will intercept the first few bytes of data sent to the board after a
connection is opened. If a sketch running on the board receives one-time configuration or other data when it
first starts, make sure that the software with which it communicates waits a second after opening the
connection and before sending this data.

The Uno contains a trace that can be cut to disable the auto-reset. The pads on either side of the trace can
be soldered together to re-enable it. It's labeled "RESET-EN". You may also be able to disable the auto-reset
by connecting a 110 ohm resistor from 5V to the reset line; see this forum thread for details.

USB Overcurrent Protection

The Arduino Uno has a resettable polyfuse that protects your computers USE poris from shorts and
overcurrent. Although most computers provide their own internal protection, the fuse provides an extra layer
of protection. If more than 500 mA is applied o the USE port, the fuse will automatically break the connection
until the short or overload is removed.

Physical Characteristics

The maximum length and width of the Uno PCB are 2.7 and 2.1 inches respectively, with the USB connector
and power jack extending beyvond the former dimension. Three screw holes allow the board to be attached to
a surface or case. Note that the distance between digital pins 7 and 8 is 160 mil (0.16"), not an even multiple
of the 100 mil spacing of the other pins.

E E’ RadiosparRes RADIONICS /a
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How to use Arduino

Arduino can sense the environment by receiving input from a variety of sensors and can affect its
surroundings by controlling lights, motors, and other actuators. The microcontroller on the board is
programmed using the Arduino programming language (based on Wirng) and the Arduino
development environment (based on Processing). Arduino projects can be stand-alone or they can
communicate with software on running on a computer (e g. Flash, Processing, MaxMSP).

Arduino is a cross-platoform program. You'll have to follow different instructions for your personal
0S5. Check on the Arduino site for the latest instructions. http:Yarduino.cc/en/Guide/HomePage

Linux Install Windows Install | Mac Install |

Once you have downloaded/unzipped the arduino IDE, you can Plug the Arduino to your PC via USE cable.

Blink led

Mow you're actually ready to “burn” your B e | Arduims ime o
first program on the arduino board. To
select “blink led”, the physical translation Ce(E)

of the well known programming “hello
world”, select

nrt ladPin = L13f Af 1ED cobmecced T ilgital pin 13

File>Sketchbook:> -
Arduino-0017>Examples> T T
Digital>Blink o naetiearan, orrERT e T

1

Once you have your skecth you'l 1) o it o o ad ver sgen,
see something very close to the ' '
screenshot on the right. ;

1 Loogi)

-H Ueite(ledPin, HICH|; A/ =et the LED oo
deLay (1000 # walt for & aedond

In Tools>Board select GicalVrite{jedein, LOW: g7 et che LED oft

ay 1000] /4 wait for m ascond

MNow you have to go to
Tools>SerialPort

and select the right serial port, the
one arduino is attached to.

hll-_ C
Done compiling. m g;-ll_(_l
el

Press Compile button »
[ta check r[.;“- errors) Upload TX RX Flashing Blinking Led!
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Dimensioned Drawing
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Terms & Conditions

1.  Warranties

1.1 The producer wamants that its products will conform to the Specifications. This wamanty lasts for one (1) years from the date of the sale. The
producer shall not be liable for any defects that are caused by neglect, misuse or misireatrment by e Customer, including improper installation or testing.
or for any products that have been atered or modied in any way by a Customer. Moreover, The producer shall not be Fable for any defects that resuit from
Customer's design, specifications or instructions for such products. Testing and ofher guality confnol techniques are used to the extent the producer deems
NEecessany.

12 any products fail to conform to the warmanty set forth above, the producer’s sole liability shall be to replace such products. The produces's Rability
shall be limited to products that are determined by the producer not to conform fo such warmanty. If the producer elects to replace such products, the
producer shall have a reasonable time to replacements. Replaced products shall be wamranted for a new full warranty peniod.

1.3 EXCEPT AS SET FORTH ABOVE, FRODUCTS ARE PROVIDED "AS I5™ AND “WITH ALL FAULTE." THE FRODUCER DISCLAIMS ALL OTHER
WARRANTIES, EXFRESS OR IMPLIED, REGARDING PRODUCTS, INCLUDING BUT MOT LIMITED TO, ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE

14  Customer agrees that prior to using any systems that indude the producer products, Customer will st such systems and the functionality of the
products as wsed in swch systems. The producer may provide technical, applications or design advice, quality charactesization, refiability data or other
senvices. Customer acknowledges and agress that providing these senices shall not expand or otherase alter the producer's wamanties, as set forth
abowe, and no additional obligations or labilities shall arise from the producer prowiding such senvices.

1.5 The Arduino™ products are not authorzed for use in safety-critical applications where a failure of the product would reasonably be expecied to cause
seyere personal injury or death. Safety-Critical Applications include, without limitation, Ife support dewices and systems, equipment or systems for the
operation of nuclear faciliies and weapons systems. Arduino™ products are neither designed nor intended for use in military or aerospace applications or
emmaronments and for autormotive applications or emvircnment. Customer acknowledges and agress that any such use of Arduino™ products which is solely
at the Customer's risk. and that Customer is solely responsible for compliance with al legal and regulatony requirements in connection with such usa.

1.6 Customer acknowiedges and agrees that it is solefy responsible fior compliance with all legal, reguiiatory and safety-related requirements conceming its
products and any use of Ardung™ products in Customer's applications, nobwithstanding any applications-related information or suppart that may be
prowidied by the producer.

2 Indemnification

The Cushormer acknowledges and agrees to defend, indemnify and hold hammless the producer from and against any and all thind-party losses, damages,
liabilities and expenses it incurs te the extent directy caused by (i} an actual breach by a Customer of the representation and wamanties made under this
terms and conditions or (ii) the gross neghigence or willful misconduct by the Customer.

3. Consequential Damages Waiver

Inme«entﬂ'lemshdhehdiemﬂ'e&mwavﬂlrdpamﬁformymwlm indirect, punitive, nddental, consequential or
:cemg:a'y in connection with or arising out of the products prowded harsu regardiess of whether the producer has been advised of the
possiblity of damages. Thlasammmllﬂrl'?meﬂ'neberﬁlnaumdﬂEmtypam

4. Changes to specifications

The producer may make changes to specifications and product descrplions at any tme, without nofice. The Customer must not rely on the absence or
charactenstics of any features or instructions marked reserved” or “undefined.” The producer resenves these for future definition and shall have no
responsibility whatsoever for conflicts or incompatiblites ansng from future changes to them. The product information on the Web Sie or Materals is
subject to change without notice. Do not finalize a design wath this information.

Enviromental Policies

The producer of Arduino™ has joined the Impatio Zero@®
policy of LifeGate.it. For each Arduino board produced is
created / looked after half squared Km of Costa Rica's
forest's.
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Labview technical

NATIONAL LabVIEW®
NSTRUMENTS’ Technical Note 021

|
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Useful Techniques for LabVIEW*

This technical note contains shortcuts and useful techniques for LabVIEW and includes
references to the corresponding sections of the LabVIEW manual set.

General Techniques

Kevboard Equivalents

Many LabVIEW menu options have keyboard shortcuts. For example, to create a new Panel
window, you can select the New option from the File memu or press the keyboard equivalent
<ctr]l- N> (for LabVIEW for Windows) or =meta-IN-= (for LabVIEW for Sun). The following
table gives frequently used shortcuts for LabVIEW for Windows and for Sun.

LabVIEW Kevboard Shortcut Action
Windows Sun
=ctrl-B= =“meta-B= Femove all bad wires from the diagram
=ctrl-F= =meta-F= Flip between the Panel and Diagram windows
<ctrl-H= <meta-H> Show/Hide the Help window
<ctrl-I= <meta-N= Create a new VI
=ctrl-Q <meta- Q- Quit the current session of LabVIEW
=ctrl-B= <meta-F= Fun the current VI
=ctrl-W= “meta- W= Close the current VI
<gtrl- = “meta- = Stop the current VI

Refer to the Using LabVIETW Menus section of Chapter 1 m the LabTVIEW User Manual.

Moving Objects Precisely

You can move selected objects very small distances by pressing the armow keys on the kevboard
once for each pixel vou want the objects to move. Hold down the arrow keys to repeat the
action. See the Moving Objects section in Chapter 2 of the LabFIETW User Manual.

340453-01 © Nafional Instruments Corporarion 1992, All rights reserved. October 1952
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Selecting Multiple Items

To select more than one object, <shifi-click on each additional object you want to select. You
can also <shaft>-click on a selected obyect to deselect 1t. See the Selecting Objects section 1n
Chapter 2 of the LabVIETW User Manual and the Resizing Objects section of Chapter 3 of your
LabVIEW getting started manual.

.

r Contrel 1] 1 | [Sentrel 1 :

to select a - .

Cantal 2 second O'bject, 1 [Condral 2] 0
Elﬂ.l:ll:l i 0100 tt

Cloning Objects

To clone objects, select the objects to be copied. hold down the <ictrl> key (for LabVIEW for
Windows) or the <meta key (for LabVIEW for Sun). and drag the duplicates to the new
position. The original objects remain where they are. See the Duplicating Objects section in
Chapter 2 of the LabVIEW User Manual or the Creating the VI section of Chapter 4 of vour
LabVIEW getting started manual

Q @ &)

Control 1 contrall] [Eentrai 1] 1 [Cantrai 1]

o ] - oo N B oo |- v

Constraining an Operation

If vou hold down the <shift~ key while cloning or moving objects, LabVIEW restricts the
direction of movement honzontally or vertically, depending on which direction vou move the
mouse first. Refer to the Moving Objects section in Chapter 2 of the LabVIEW User Manual or
the Creating the VT section of Chapter 4 of your LabVIEW getting started manual.

Changing Tools

When LabVIEW 15 m edit mode, pressing <tab> toggles through the tools. If the front panel 1s
active. LabVIEW rotates from the Operating tool [4] to the Positioning tool[%] to the Labeling
tool [A] to the Coloring tool[#]. If the block diagram is active, LabVIEW toggles through the
tools in the same order. except that it selects the Wiring tool [ instead of the Coloring tool.
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If you press the space bar while the block diagram 1s active, LabVIEW toggles between the
Positioning and Winng tools. If you press the space bar while the front panel 1s active,
LabVIEW toggles between the Positioning and Operating tools. Refer to the Tools section in
Chapter 1 of the LabVIEW User Manual.

Placing Objects

If you hold down the <ctrl= key (for LabVIEW for Windows) or the <meta~ key (for LabVIEW
for Sun) while clicking on an empty area of the front panel or block diagram. the Controls or
Functions menus pop up. respectively. LabVIEW places the selection you make in the vicinity
i which you clicked. With pop-up menus yvou can place an object where vou want 1t. mstead of
moving an object after selecting it from a pull-down menu. When vou select an object from a
pull-down menu, LabVIEW places the object where yvou last clicked in the window. Refer to the
Common Front Panel Control and Indicator Options section m Chapter 10 of the LabVIEW User
Manual and the Creating the Front Panel section of your LabVIEW getting started manual.

Replacing Controls or Nodes

To replace one object with another without changing the labels, position. description. and
connections yvou have created. vou can use the Replace option of the object's pop-up menu. See
the Common Front Panel Control and Indicaror Options section in Chapter 10 and the Replacing
and Inserting Block Diagram Objects section in Chapter 11 of the LabVIEW User Manual.

[utput ¢

Cmmen_]

Show Label
Description...
Show Terminals
Replace

Strucis i Lonsionis ? |
Arithmetic
Trig & Log ]
Comparison 4
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Front Panel Techniques
Incrementing Digital Controls More Quickly

If vou press the <shift> key while clicking on the mcrement or decrement buttons of a digital
display. the display increments or decrements very quickly. The size of the increment increases
by successively higher orders of magnitude; for example, by ones, then by tens. then by
hundreds. and so on. As the range limit approaches, the increment decreases by orders of

magnitude. slowing down to normal as the value reaches the limit. See the Digital Controls and
Indicators section 1n chapter 5 of the LabVIEW User Manual.

Skioo |

<Shft=-click to mcrement
of decrement a digital control quickly.

Entering Items in a Ring Control

If you press <shift-enter after typing text into a ring control, LabVIEW creates a new empty
item following the current one and places the cursor 1n the new entry. See the Ring Controls
section in Chapter 5 of the LabVIEW User Manual.

=Shift-enter=
places the cursor in F irg C-i-ntr'-:-

- an empty tfem after :
m IE' the curment item. El

Coloring

To change the current color of the Coloring tool. pop up with the Coloring tool. The following
palette appears in color.
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Foreground: Bankgrnund:.

All for both Other keys toggle
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As you move through the palette while pressing the mouse button, the object on which vou
popped up redraws with each color the cursor touches. If you release the mouse button on a
color, the object retains the color you selected. which 1s the new current color. When vou click
on other objects with the Coloning tool, they also become the current color vou selected. To
cancel the operation without changing the current color, move the cursor out of the palette and
release the mouse button.

If you select the box contaiming a T, the current color becomes transparent. If vou press =f-, the
color you select applies only to the foreground of an object. If vou press <b>, the color applies
to the background. Pressing <a applies the same color to the foreground and background.
Pressing other keys toggles between foreground and background when you move the Coloring
tool through the palette. If you select different current foreground and background colors at the
same time, LabVIEW remembers both selections.

To change the current color without using the palette, <ctrl=-click (for LabVIEW for Windows)
or =meta-chick™ (for LabVIEW for Sun) with the Coloring tool on an object whose color you
want to duplicate. The current color becomes the color of the selected object. When vou click
on another object with the Coloring tool, that object takes on the new current color.

See the Coloring Objects section in Chapter 2 of the LabFIETW User Manual.

Block Diagram Techniques
Inserting New Nodes into an Existing Wire

You can use the Insert option of a wire pop-up menu to splice a new node into the wire. as
shown i the following illustration.

m E I]es:l'ip tion...

List ErTors ra 1.1
stripts i Eonslants b |
Trig & Log W B B B i =
Comparison 4
Conversion k [‘;‘p B} E}:;—, [ﬂ} E?}
String 4
Array & Cluster 4 .
File 170 o[> B [ [ [ &
Dialog & Date/Time P
Miscellaneous M Ca T E:}
Ui ...
finalysis 4
DA o| [ > T =

Nol

If you msert a node that has more than one input terminal. LabVIEW wires ether the top or
bottom ternunal. depending on where yvou pop up. If you pop up exactly on the wire or one pixel
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beneath the wire. LabVIEW wires the top input termunal. as shown in the following illustration.
If you pop up one pixel above the wire, LabVIEW wires the bottom mput termunal.

[l I E
o Description... EEI = J}‘--la'ﬁ

List Errors

Insert Sirunis ¥ Lnnslants F |
Arithmetic b
Trig & Log W B B e e
Comparison ¥
Conversion M e e T
Conve RN
Array & Cluster L= -
File 1/0 o B> B [ B ]
Dialog & Date/Time Pk —
siscellaneous B0 o T "E"'
i ...
Analysis K A || T 33
DAD 4 ks
Mol 0r

See the Replacing and Inserting Block Diagram Objects section in Chapter 11 of the LabVIEW
User Manual.

Preconfigured Arrayv and Cluster Nodes

You can select the most common array and cluster functions from the Array Tools and Cluster
Tools palettes of most terminal or wire pop-up menus. if the data type of the terminal or wire 15
array of cluster. Functions you select from these palettes appear with the correct number of
terminals to wire to the object on which you popped-up. For example, selecting an Unbundle
function from the Cluster Tools palette of a wire containing a cluster creates an Unbundle
function that already has the correct number of outputs. See Chapter 7. Array and Cluster
Functions. of the LabVIEW Function Reference Manual.

Description...
List Errors
Insert

Pop up on the wire to get the
Array Tools palette.

EEE @]ul@“ E=|| &
- | |m= e vy [
SEE

.
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Cluster containing

four elements When you select an

Unbundle node from the

Cluster Tools palette
E_I'IEII'IQE FD Control of a cluster contaming —
Find Indicator four elements. the Cluster containing
Bide Dandral Unbundle nede appears - four elements
Show Label with four output ey — [t
Data Operations > terminals. -
Cluster Tools F ]
Array Tools » —T

Unbundle

Resizable Nodes

Some of the array and cluster functions have a vaniable number of termunals. You can add and
remove terminals by using the pop-up menu commands Add and Remove (the names of these
commands vary shghtly according to the function from which you popped up the menu). An
easier way to do this is to enlarge or decrease the node vertically from any commer using the
Positioning tool. See the Nodes section in Chapter 10 of the LabFIEW User Manual.

. O=m QR
Add Input
... == Hemave {nput

Show Label

5et Breakpoint
Description...
Replace [

Changing the Direction of a Wire

Pressing the <space™ bar while vou wire changes the direction that the current wire branch
leaves the last tack point. Thus. if you accidentally move horizontally from a tack point but want
the wire to move down initially, pressing the space bar changes the 1mitial orientation from
horizontal to vertical. See the Basic Wiring Techniques section in Chapter 11 of the LabFIET
User Manual.

N @

TDiL | Press the space bar to change :
- the orientation of the wire. - -



Selecting Wire Segments

Clicking once on a wire selects a single horizontal or vertical segment of the wire. Double-
clicking selects a branch. a section of a wire with only one source and one destination. Tnple-
clicking selects an entire wire. See the Selecting, Moving, and Deleting Wires section

i Chapter 11 of the LabVIEW User Manual.

segment
w1l / b Ep -.-.-I?;
. o
Junction t} serment I.;fx
. J—E;; g7 > i
4 segments One click Twao clicks Three clicks
selects a segment. select a branch. select an entire wire.

Removing the Last Tack Point

Clicking while wiring tacks a wire down. =Ctrl>-clicking (for LabVIEW for Windows) or
=Meta=-clicking (for LabVIEW for Sun) while winng removes the last tack pomt, and =-Ctrl>-
clicking or =Meta=-clicking again removes the next-to-the-last tack point. If the last tack pont
15 the terminal, <Ctrl=-clicking or =Meta=-clicking removes the wire.

bend.....
5 & last tack point
e}~ [oEL)- -
o last tack point bend @"
1. The first <Ctrl=-click or <MMeta-=-click 2. The second <Ctrl>-click or
removes the last tack pomt. =Meta=-click removes the

next-to-last tack pomt.

@] - bend

> DL
3. The third <Ctrl>-click or <Meta=-click 4. No wire remains.
removes the wire because the last
tack point is the terminal.

Wiring to Off-Screen Areas

If you need to wire to an off-screen area_ click on the 1mtial object and wire to the edge of the
screen. At the edge of the screen. double-click i an empty area of the diagram to temporanly
terminate the wire. Then scroll the screen to view the destination object, click on the unfimished
wire and resume wiring to the destination object. See the Wiring to Off-Screen Areas section in
Chapter 11 of the LabVIEW User Marual.
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